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 PC (4.0 only): Every time I pop my Photoshop CD into my

CD-ROM drive, a screen appears with four options (Explore

the CD, Photoshop Overview, Install Photoshop, and Quit

to Desktop). I find this annoying and time consuming, and

occasionally it even makes my computer freeze up. Is there

any way to stop this thing from popping up every time

I insert the CD?

Yes. You can override the Photoshop CD’s autoplay feature by

holding down the Shift key as you insert the CD (you may have

to hold the Shift key down for ten seconds or longer, depending

on your system). Once your system recognizes the CD, open Win-

dows Explorer or the My Computer icon on the desktop, right-

click on the CD-ROM drive, and choose Explore from the pop-up

menu. The Photoshop CD should open up in the Windows Ex-

plorer. Don’t double-click on the CD-ROM icon; that’s what causes

the autoplay feature to start up.

Can I run Photoshop on a DEC Alpha?

Sorry, there is currently no version of Photoshop for the DEC

(Digital Equipment Corporation) Alpha processor. Although DEC

has created an emulation package that allows Windows NT appli-

cations to run on DEC Alpha systems, Photoshop was not written

for that platform. Because Adobe didn’t test Photoshop on the

DEC hardware, we cannot support Photoshop running under this

configuration.

PC/Mac: I just added a scanner to my system and it’s great,

but a colleague tells me I’m scanning at too high a resolu-

tion. My files do seem to take a long time to work with at
1,200 dpi. What’s a good rule of thumb for what resolution

to use when scanning?

We’re glad you asked. Working at an appropriate image resolu-

tion is critical in Photoshop, and it’s important to know what your

maximum output image resolution needs to be before you begin

to scan, create, or import an image in Photoshop.

Ultimately, how you’ll use the image will determine what reso-

lution is best. One widely accepted rule of thumb for print output

is to use an image resolution (described in pixels per inch) that’s

twice the line-screen frequency of your final output device.

Screen frequency (also called screen ruling) refers to the number

of halftone dots or spots per linear inch, and is expressed in lines

per inch, or lpi—not dots per inch, or dpi. (This formula assumes

you’re working with color or grayscale images to be output on a

PostScript printer; black-and white bitmap images are the excep-

tion and can be scanned at the resolution of the output device.)

For example, if your printer’s screen ruling is 85 lpi, typical for

newspaper printing, you’ll get good results with images that are

scanned at around 170 pixels per inch (assuming you don’t shrink

or stretch them in the layout of your document—if, for example,

you plan to stretch the image by 50 percent, you should increase

the resolution that you scan at by 50 percent). Screen frequencies

for most PostScript printers typically range from approximately

65 to 180 lpi. Check with your printer for appropriate settings for

the job at hand before you start scanning in earnest.

An appropriate resolution for images to be displayed only on a

computer screen, such as images for a Web page, is even lower,

and is based on a one-to-one match with the pixels on the moni-

tor—typically 72 to 96 pixels per inch.

It’s a common and understandable instinct to want to use the

maximum pixel resolution of your scanner or your printer when

creating images (the more the merrier, bigger is better), but it

should be curbed. Using maximum resolution almost always re-

sults in files that are needlessly—sometimes stunningly—large.

This fills up your hard disk, slows down Photoshop and printing,

and, in some cases, may crash your system—all with no improve-

ment in image quality.

For more information, refer to “Getting Images Into Photoshop”

in the Adobe Photoshop 4.0 User Guide or “Scanning, Importing,

and Exporting Images” in the Adobe Photoshop 3.0 User Guide.

PC/Mac: Sometimes when I try to open an Illustrator file

in Photoshop, I get an error message that says something

about the source rectangle being empty. I also occasionally

get a similar message when copying objects from Illustrator

to Photoshop, and sometimes there’s no message but ele-

ments simply don’t show up in my Photoshop document.

Any idea what’s going on here?

It sounds like you’re trying to import objects from a print-dis-

abled layer in Illustrator 6.0 or 7.0. Photoshop won’t accept such

objects, either in an imported Illustrator document or over the

Clipboard. When it encounters such objects, it might return the

warning message “Could not complete your request because the

source rectangle is empty.”

To get around this error, open the file in Illustrator and enable

the layer to print by double-clicking the layer name, selecting the

Print option, and clicking OK. Then either resave the document

and reopen it in Photoshop or select the desired objects and copy

and paste them into Photoshop.
Fading fast
Photoshop 4.0 introduced the fade-filter feature:  immediately

after running a filter, you can modify the opacity and blending

mode of the filter you’ve just applied (by selecting Fade [filter

name] from the Filter menu). Photoshop 4.0.1 (available on-

line) expanded this new function to include painting tools.

Of course, you can achieve many of the same effects of the

Fade function by combining the opacity and blending options

in your Paintbrush Options palette. But you’d have to plan

ahead and set them up before you actually put the pixel to

the page. The Fade function is more forgiving; it lets you ex-

periment without making a commitment. Try it and see how

much fun it can be.
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Micro Tip

Toggle Preserve

Transparency

on or off for any

nonbackground

layer using the

Forward Slash

(/) key.
PC/Mac: I sometimes scan color negatives and bring them

into Photoshop, but the color seems all wrong. If I simply

invert the color, it’s still wrong. It looks like there’s an

orange/blue cast from the negative material. I’ve tried

adjusting the colors manually, but it still doesn’t always

come out right. There must be a better way to do this, right?

Right. But before we tell you about it, here’s some information

about the problem you’re encountering. It’s caused by the orange

medium of color negatives. Simply inverting the colors (using the

Invert command) doesn’t compensate for the orange negative

material. You can try using Photoshop’s color-adjustment tools to

remove the orange cast, but you may not be able to get satisfac-

tory results unless you’re very experienced at color correction and

have a well-calibrated monitor.

There’s a simpler way to fix this: use Cytopia Software’s CSI

Negative plug-in, which is designed for this very purpose. Contact

Cytopia Software at (415) 364-4594 or through their Web site at

www.cytopia.com. Or find out if your slide-scanner software can

automatically compensate for the color of the negatives.

PC/Mac: When I remove a feathered object from a white

background and superimpose it on a different background,

the composited object appears with an unnatural “halo”

of pixels around it. How can I fix this?

A good way to spirit away these unwanted pixels—we call it

“defringing” the object—is to use Photoshop’s Layer Options.

To do so manually, try this. In a multilayer document, open the

Layer Options dialog box (double-click the object’s layer, or, in

Photoshop 4.0x, choose Layer Options from the Layer menu). Be

sure that the Preview box is checked, the Opacity is set to 100%,
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Use the controls in the

Layer Options dialog

box to eliminate any

leftover “fringe” pixels

from a feathered object

in a composited image.
the Mode is set to Normal, and the Blend If pop-up menu choice

is set to Gray. Drag the white triangle at the right end of the This

Layer slider toward the center. This causes white pixels to begin to

drop out, and allows the background pixels (or those on the layer

underneath) to show through. (The image doesn’t update dy-

namically as you move the slider; you’ll see the effects only when

you release the mouse button to let go of the slider.)

You control the “drop-off” point (that is, how much of the white

edge disappears) by moving the slider from side to side; carefully

slide the triangle far enough to the left to make all the white

fringe pixels disappear.

Sometimes, however, the edge of your image stands out in

stark contrast to the background, making the composited image

look almost as artificial as it did with the fringe pixels (not to men-

tion the eerie effect if you push it so far that non-edge pixels start

to drop out, too). Fortunately, with a simple keystroke, you can

split the blend sliders, effectively doubling the number of con-

trols you have to help refine your blending process. Splitting the

controls allows you to soften the edge of the transition. To split

any of the sliders in the Layer Options dialog box, press the Alt

(Windows) or Option (Macintosh) key while you drag the slider.

(After splitting a triangle, you’ll see two values displayed above

the slider where previously there was only one.)

In this example, we’ll need only one more slider to control the

range of white (and nearly white) pixels that we want to drop out.

After you’ve dragged the entire white triangle in the This Layer

slider to the left, hold down Alt or Option, click on the right side of

the white triangle, and drag it back to the right.

It may require some experimentation, depending on the na-

ture of your image, but with a little practice you should be able to

get the white fringe pixels along the edge of your pasted image

to drop out, leaving a soft, natural-looking transition along the

edge. And, of course, you can use this same split-control tech-

nique in a variety of ways—notably, with combinations of opacity

settings and blending modes—to give you greater control over

layer compositing.

PC/Mac: Photoshop keeps giving me a message telling me

that my scratch disk is full, even though I know I have plenty

of space. What’s up?

When you get a message from Photoshop saying your scratch

disk is full, it’s usually telling you the truth. (A scratch disk is an

amount of space on your hard disk that Photoshop uses to per-

form its operations.) The exact amount of space it needs depends

on several factors, but in most cases you can use the following

guideline for a rough estimate: you’ll need approximately three to

five times the size of your document for scratch-disk space.

Keep in mind that the size of the file referred to here is the size

of the file once it’s open in Photoshop. (One notable exception to

this rule is 1-bit, black-and-white files in Photoshop’s bitmap

mode: these files can require up to ten times the file size for

scratch-disk space.) Don’t forget that file formats that use com-

pression will appear much smaller when you look at them in the

Windows Explorer or the Macintosh Finder than when they are

opened in Photoshop. File formats supported by Photoshop that

sometimes or always use compression include Photoshop’s native

PSD format, TIFF, JPEG, GIF, PNG, and PICT. And bear in mind that

file sizes viewed within the operating system don’t always reflect

the file’s true size due to a variety of reasons, most notably the
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way your operating system allocates space on a hard drive. To get

a more accurate idea of how large your file is when it’s open in

Photoshop, take a look at the number reported by the Document

Size option in the lower left corner of your image window.

Also, be sure that you have your scratch disk designated on the

drive where you think it is; don’t just assume. Ideally, it should be

on a fast, defragmented, local (that is, not networked), nonre-

movable media drive. Check your scratch-disk designation by

choosing Preferences from the File menu, and then choosing

Scratch Disk (3.0.x) or Plug-Ins & Scratch Disk (4.0.x). (A secondary

scratch disk “kicks in” when the first one is full, so it’s a good idea

to choose one if you have multiple drives available.)

There is one relatively obscure situation in which Photoshop

will incorrectly report that your scratch disk is full even if it’s not: if

you have more RAM allocated to Photoshop than you have avail-

able scratch-disk space. The solutions for this would be to allocate

less memory to Photoshop, which may make it run slower, or—

preferably—to free up more disk space. Note that this would af-

fect you only if you have lots of RAM and very little free disk space,

and it’s likely that in this situation you’d be about to run out of

disk space anyway, so freeing up some disk space (or buying

some more) is the hands-down best solution, regardless of how

much RAM you’ve got.

PC/Mac (4.0x): When I write a PDF file directly from Acrobat

Distiller, I have options for compression and other settings,

but when I write a PDF file from Photoshop it never asks me

to choose any of that stuff. What settings does Photoshop

use for writing PDF files?

Photoshop automatically creates PDF files using JPEG com-

pression—equivalent to the “high” quality compression setting

(6) that you can select when saving a JPEG from Photoshop—and

Adobe Acrobat 2.1 compatibility.

Mac: I recently upgraded my system software, and now the

sliders in my Gamma Control Panel no longer have any ef-

fect. Isn’t the Gamma Control Panel compatible with my

new system software?

Some combinations of system software and video hardware

cause the controls in the Macintosh Gamma Control Panel to stop

working. Fortunately, you should be able to get around this limi-

tation. Using the Monitors & Sound Control Panel (or Monitors

Control Panel, depending on what version you’re using), tempo-

rarily switch to a different color depth. For example, if you’re run-

ning your monitor at the Millions of Colors setting, switch to the

Thousands of Colors (or the 256 Colors) setting. Adjust the

Gamma controls, and then, when you’re done, you can switch

back to your preferred color depth.

Mac: I just upgraded to Mac OS 8 and can no longer use my

Epson scanner in Photoshop. Sometimes I get a message

telling me that I don’t have enough memory, and sometimes

the system just freezes up. Isn’t Photoshop compatible with

Mac OS 8?

You bet it is—but when you upgrade system software you may

also have to update your plug-ins, Twain data-source files, or

other third-party components for full compatibility. Contact the

developer of any third-party component that’s giving you trouble

for information on the availability of an update. Updated Twain
files are now available from Epson.

You might also want to use ScanTastic from Second Glance

Software (360-692-3694 or www.secondglance.com). This Photo-

shop scanning plug-in lets you scan directly into most programs;

it works fine with Mac OS 8, Photoshop, and Epson scanners (as

well as HP and Apple scanners).
Mac (4.0.x): When I click on the Build Tables Using Apple

ColorSync button in Photoshop’s Separation Tables dialog

box, nothing happens. On a friend’s Mac, this brings up

a color-management dialog box. Why is mine broken?

You’re probably missing the CMS (color-management system)

support files that need to be installed in your System Folder (you

also need the ColorSync Extension, of course).

Make sure that you have installed either the PSLABPCS.ICM

(Photoshop 4.0) or PSLABPCS.PF (Photoshop 4.0.1) file, in addi-

tion to at least one CMYK printer profile and one monitor profile,

in the ColorSync Profiles folder (located in the Preferences folder

within your System Folder).

If you find that one or more of your color-management files is

missing, the simplest way to make sure you have what you need

is to do a custom installation of Photoshop and select ICC Profile

support from the plug-ins section of the installer program. Make

sure that your ColorSync Extension is enabled when you install

Photoshop. (Photoshop doesn’t install the extension, so if you

don’t have it, check your System CD-ROM, or download it from

www.colorsync.apple.com.) ◆
Change your background layer
Have you ever wanted to add a new background layer to

your document? There are several ways to add a new layer

in Photoshop, but most of them result in a transparent,

nonbackground layer.

To add a nontransparent background layer, you can create

a nonbackground layer and then flatten or merge down to

change that layer into a background layer. But here’s an

easier way.

1. Choose Layer from the New submenu of the Layer menu

in version 4.0, or New Layer from the Layers palette menu

in version 3.0x.

2. Click on the Mode pop-up menu in the New Layer dialog

box. Scroll to the bottom of the list. You should see an

extra mode called Background. Select the background

mode option, and then click OK. The new layer you’ve just

created will automatically appear as a nontransparent

background layer.

Of course, the choice for background mode will be available

only in a document that currently has no Background layer;

since a document can have only a single Background layer,

you can’t add a second one.
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